
  

LSS GmbH www.lss-lighting.de 
Am Eichenberg 1, 04600 Altenburg  Tel.: +49 3447 835500 Fax: +49 3447 861611 
Warnemünder Str. 1, 01109 Dresden Tel.: +49 351 79565690 Fax: +49 351 79565699 

 

 
 

LSS 
 
 
 

Handbuch 
 

MasterPort 2  

 
 

 
 

 

Multiprotokollfähiger 4fach-Netzwerkknoten für DMX512 und Power-
over-Ethernet IEEE 802.3af mit einem 24V-Power-DMX-Signal 

  



MasterPort 2 

2 

   

 

 

 

 

 

 

 

      

 

 

 

Datum:  11.05.2017 

Softwarestand: 1.11  

    

Alle Rechte vorbehalten. Kein Teil dieses Handbuch darf in irgendeiner Form (Druck, Fotokopie, 
Mikrofilm oder ein anderes Verfahren) ohne die schriftliche Genehmigung der LSS GmbH reprodu-
ziert oder unter Verwendung elektronischer Systeme verarbeitet, vervielfältigt oder verbreitet 
werden. 

 

Die LSS GmbH haftet nicht für Schäden infolge von Fehlgebrauch sowie Reparaturen und Abände-
rungen, die von dritter, nicht autorisierter Seite vorgenommen wurden. Dieses Handbuch wurde 
mit großer Sorgfalt erstellt. Eine Haftung für leicht fahrlässige Fehler, z.B. Druckfehler, ist jedoch 
ausgeschlossen. 

 

Alle in diesem Handbuch genannten Bezeichnugen von Erzeugnissen sind Marken der jeweiligen 
Firmen. Aus dem Fehlen der Markenzeichen ©, ® bzw. ™ kann nicht geschlossen werden, dass die 
Bezeichnung ein freier Markenname ist. 

 

 
 

Die Licht-, Steuer- und Schaltanlagenbau GmbH ist zertifiziertes Mitglied der Profibus-
Nutzerorganisation PNO. 

 

 
Die ESTA-Manufacturer-ID der Licht-, Steuer- und Schaltanlagenbau GmbH ist „LS“ (76,83 / 
4Ch,53h). 
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Hinweise zu diesem Handbuch 

Mit diesem Handbuch erhalten Sie Hinweise und Informationen über die Funktion und Konfigura-
tion des MasterPort 2.  

 

Dieses Handbuch gilt für den MasterPort 2. Wie alle anderen Produkte aus dem Hause LSS GmbH 
unterliegt der MasterPort 2 einer ständigen technischen Weiterentwicklung. Deshalb werden hier 
unter Umständen Funktionen und Einstellungen beschrieben, die für den von Ihnen genutzten 
MasterPort 2 nicht verfügbar sind. 

Dieses Handbuch nutzt folgende Symbole, um für Sie wichtige Hinweise zu Ihrer Sicherheit und zur 
Konfiguration kenntlich zu machen. 

 

Hier erhalten Sie zusätzliche Informationen.  

 

 

Ein Achtung weist Sie auf Situationen hin, in denen Entscheidungen zu technischen 
Problemen mit dem Gerät oder zu Datenverlusten führen können. 

 

 

Eine Warnung bezeichnet Situationen, in denen Verletzungen oder Schäden für Leib 
und Leben auftreten können. 

 

 

Sicherheitshinweise 

Der Umgang mit dem MasterPort 2 ist nicht gefährlich. Schutzisolierung und weitere Sicherheits-
maßnahmen verhindern zuverlässig, dass Sie mit gesundheitsschädlichen Spannungen und Strö-
men in Berührung kommen. Beachten Sie aber folgende Hinweise: 

 

 Nehmen Sie niemals sichtbar beschädigte Geräte in Betrieb! 

 Liegt der Verdacht auf einen Defekt vor, trennen Sie das Gerät sofort von der 
Stromversorgung! Sichern Sie das Gerät gegen Wiederinbetriebnahme! 

 Trennen Sie vor der Abnahme der Rückwand das Gerät unbedingt vom Netzteil! 

 Reparaturen dürfen nur von einem autorisierten Händler oder von Mitarbeitern der 
LSS GmbH durchgeführt werden. 
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Hinweise zur Handhabung 

Der MasterPort 2 ist für einen 24h Dauerbetrieb konzipiert. Dennoch sollten Sie folgendes beach-
ten:  

 

 Setzen Sie das Gerät nur zu seinem bestimmungsgemäßen Zweck ein! 

 Vermeiden Sie extreme mechanische Belastungen! 

 Vermeiden Sie jegliche mechanische Einwirkungen auf das Display! 

 Wenn nötig reinigen Sie das Display ausschließlich bei ausgeschaltetem Gerät. Be-
nutzen Sie nur ein angefeuchtetes Tuch 

 Vermeiden Sie direkte Nässeeinwirkung sowie übermäßige Hitzeeinwirkung auf das 
Gerät! 

 Decken Sie die Belüftungsöffnungen niemals ab! Brandgefahr! 

 Montieren Sie das Gerät nicht unmittelbar über Scheinwerfern! 

 



MasterPort 2 

8 

   

 

 

Der MasterPort 2 
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Überblick 

 

Der LSS MasterPort 2 ist ein Ethernet-/DMX-Netzwerkknoten. Er ist voll RDM-fähig und unterstützt 
den RDM-Traffic aller angeschlossenen Geräte. Darüber hinaus können die RDM-Meldungen aus-
gelesen und an entsprechende Anzeigegeräte gesendet werden.  

 

Mit dem LSS MasterPort 2 können Ethernetdaten auf bis zu vier DMX-Universes umgesetzt wer-
den. Jedes Universe ist imstande, bis zu vier Sender nach dem HTP-Prinzip zu mergen. Alle DMX-
Ports sind RDM-ready nach ANSI E1.20 2006.  

 

Der LSS MasterPort 2 CPU sind die Konvertierungen von Lichtnetzwerkprotokollen von Ethernet 
nach DMX noch schneller ausgeführt. Dabei werden wie bisher die Protokolle ArtNet, sACN, 
AVAB/IPX, AVAB/UDP, ShowNet unterstützt. Daneben ist es mit dem MasterPort 2 nun auch mög-
lich, ihn in Art-Net3-Netzwerke zu integrieren.  

 

Ein Gerät – zwei Bauformen 

Der MasterPort 2 ist in zwei Bauformen erhältlich, die in jeweils drei unterschiedliche Anschluss-
designs erhältlich sind. Als Einbaugerät kann er als Komponente von Multifunktionskanälen oder 
auch in Versatzkästen und Verteilern eingesetzt werden. Als Portable-Version wird der MasterPort 
2 mit einem Aufputzgehäuse für die Wandmontage geliefert. 
 
 
 
 
 
 
 
 

MasterPort 2 als Einbau Version   MasterPort 2 als Portable Version 
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Unterstützte Protokolle 

Der LSS MasterPort 2 unterstützt folgende Protokolle: 

 

 Art-Net  ShowNet 

 AVAB/UDP  AVAB/IPX 

 sACN  DMX512 

 

Anschlüsse 

 

Ethernet:  1x RJ45, 100MBit 

 

DMX:   4x DMX-Out XLR-5polig 

   alle XLR DMX-Out sind elektrisch isoliert 

 

Anschlussbelegung befindet sich im Anhang. 
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Funktionsübersicht 

DMX 

DMX-Ausgänge 

Gemeinsam für alle DMX-Ausgänge sind folgende Parameter einstellbar: 

 Verhalten bei Empfangsausfall aller Quellen (Abschalten, Halten, Nullen senden) 

 Breaklänge 90…999 µs 

 Mark After Break 20…999 µs 

 

Dadurch können Sie den MasterPort 2 an jedes Endgerät anpassen. 

 

Der MasterPort 2 kann nur als Protokollkonverter zwischen DMX und ethernetbasie-
renden Netzwerkprotokollen eingesetzt werden. Für Konvertierungen von Ethernet-
Protokollen muss ein LSS MasterGate eingesetzt werden! 

 

 

Ethernet 

Datentransferrate 

Der MasterPort 2 zeichnet sich durch hohe Durchsatzrate und geringe Latenz (Verzögerungszeit) in 
beiden Richtungen aus. Die Netzwerkschnittstelle ist 100MBit-fähig und die interne CPU arbeitet 
mit einem sehr schnellen Realtime-Multitasking-Betriebssystem. So ist ein maximaler Durchsatz 
von >1000 Netzwerk-Paketen pro Sekunde möglich. 

 

 

Netzwerkprotokolle 

Das Standard-Netzwerkprotokoll des MasterPort 2 bei Auslieferung ist das herstellerübergreifende 
Art-Net von ArtisticLicence. Die aktuell eingesetzte Protokollversion ist Art-Net III 1.4bd.  

 

Für AVAB Safari VLC, transtechnik NT oder zur Kommunikation mit Fremdgeräten von LDDE u.ä. 
wird das ältere Protokoll AVAB/IPX unterstützt. Für transtechnik NT – und ETC - Anlagen wird das 
Protokoll AVAB/UDP unterstützt, das einer direkten Umsetzung von AVAB/IPX auf TCP/UDP ent-
spricht. Für Anlagen der Firma Strand Lighting wird das ShowNet - Protokoll unterstützt. Daneben 
wird das Streaming-Protokoll sACN als Untermenge des ANSI-Standard E1.31 2009 unterstützt, das 
auf Multicast basiert. Der MasterPort 2 benutzt hierfür IGMPv2. 
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Remotekonfiguration 

Für alle LSS-Geräte wird die kostenlose Software ConfigCore empfohlen, die alle Features des Mas-
terPort 2 und anderer LSS-Geräte, aber auch Art-Net-Geräte anderer Hersteller unterstützt. Nur 
mit dieser Software ist es möglich, alle Geräte im Netzwerk aufzufinden und den MasterPort 2 
komplett remote zu konfigurieren. 

 

Als Art-Net-kompatibles Gerät arbeitet der MasterPort 2 problemlos mit Art-Net-Softwaretools 
anderer Hersteller, wie z.B. dem Programm DMX-Workshop zusammen (Download unter 
www.artisticlicence.com). Selbstverständlich hat der MasterPort 2 wie alle anderen Art-Net-
Geräte eine eigene OEM-ID (ab Workshop-Version 3.57 erkannt und unterstützt). Über dieses Tool 
ist auch eine eingeschränkte Remote-Konfiguration möglich. Beachten Sie, dass Art-Net hier nur 
eine Untermenge des MasterPort 2 konfigurieren kann.  

 

Auch bei anderen eingestellten Licht-Protokollen als Art-Net ist der MasterPort 2 mit 
ConfigCore immer konfigurierbar, es wird lediglich vorausgesetzt, dass der PC im IP-
Adressbereich des MasterPort 2 liegt. 

 

Licht-Parameter 

Für alle Lichtprotokolle können Sie folgende Parameter einstellen: 

 minimale Senderate ohne Werteänderung 20 ms … 4s 

 Timeout-Zeit 1...999 s (Halten usw. wird pro DMX-Out eingestellt, s. dort) 

 Timeout ist nur global einstellbar, wird aber für jedes verwendete Subnetz/Universe einzeln 
überprüft 

 

IP-Parameter 

Für alle auf TCP/IP basierenden Lichtprotokolle können Sie weiterhin folgende Parameter festle-
gen: 

 IP-Adresse  Manuell / Art-Net 2.x.x.x / Art-Net 10.x.x.x / DHCP 

 IP-Subnetz-Maske 

 Gateway-IP 

 

Merge-Verhalten 

Der MasterPort 2 kann bei Anlagen, die auf dem gleichen Subnetz/Universe senden, bis zu 4 Anla-
gen HTP-mergen. Dies zeichnet ihn von den meisten anderen Geräten dieser Art aus. Art-Net sieht 
z.B. hier nur 1 oder max. 2 Anlagen vor. 

Es werden ebenfalls Prioritäten unterstützt, wenn dies das Lichtprotokoll zulässt. Es werden aber 
keine herstellereigenen Erweiterungen, wie z.B. „Prioritäten pro Kreis“, unterstützt. 
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Anzeige-, Anschluss- und Bedien-
elemente 
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Frontseite 

Überblick 

Auf der Frontseide des LSS MasterPort 2 befinden sich die DMX-Ports und der Konfigurationsbe-
reich. 

 

 

 

 

BetriebsLED 

 

 

 

Menüeinstellung 

 

 

 

DMX-Ports 
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BetriebsLED 

Über die LEDs an der Frontseite werden die Betriebszustände des MasterPort 2 angezeigt. 

 

LED Farbe Bedeutung 

Power blau Ein: Betriebsspannung vorhanden 

Aus: Betriebsspannung nicht vorhanden 

LINK/DATA gelb Ein: Ethernet-LINK, keine Daten 

Blinkt: Ethernet-LINK, Daten 

Aus: kein LINK 

ACTIVE/FAIL  Grün 
 
 
 
 
 
Rot 
 

DMX-Port-Sammelanzeige  
An: mindestens ein DMX-Port ist aktiv 
Blinkt: mind. ein DMX-Port erhält kein Signal und ist auf HOLD  
Blitzt: mind. ein DMX-Port erhält kein Signal und sendet NULL (ZERO) 
Aus: Alle DMX-Ports sind aus 
 
Fehlermeldungen 
Blinkt: Programmierfehler – Service informieren! 
An: Sammelfehler – Service informieren!  

 

Menüeinstellung und Display 

Die Konfiguration des MasterPort 2 erfolgt lokal über ein komfortables Menüsystem. Zu diesem 
Zweck enthält das Gerät ein blau-weiß leuchtendes 20x4 LCD-Display mit stromsparender LED-
Hintergrundbeleuchtung und langer Lebensdauer. Die Lebensdauer wird noch um ein Vielfaches 
erhöht, wenn der Bildschirmschoner verwendet wird.  

 

Bedient wird das Menü mit einem Dreh/Drück-Encoder, der bereits vom LSS PowerDim bekannt 
ist. 

 

 

 

 

 

Menübildschirm 

 

 

 

 

 

Dreh/Drück-Encoder  
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Verwenden Sie den Bildschirmschoner! Dies verlängert die Lebensdauer des Displays um 
ein Vielfaches.  

 

Im Menü können Sie den Kontrast des Displays einstellen. Ein Nachregeln ist aber norma-
lerweise nicht nötig, da das Display bereits temperaturkompensiert ist. 

 

 

DMX-Ports 

Einbaugeräte 

Die Anschlüsse des LSS MasterPort 2 befinden sich direkt am Gerät. Alle DMX-Ports sind an der 
Frontseite angeordnet, der RJ45-Zugang und die Anschlüsse der externen Spannungsversorgung 
auf der Rückseite.  
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Spannungsversorgung und Ethernet 

Einbaugerät 

Überblick 

An der Rückseite des MasterPort 2 befinden sich die Anschlüsse zur Spannungsversorgung des Ge-
rätes und optionale sekundäre DMX-Ports. 

 

Spannungsversorgung 

 

 

Ethernet 

 

 

 

 

Optionale rückseitige 

DMX-Out Anschlüsse 

 

 

Portable Version 

Überblick 

 

 

 

 

 

 

         RJ45-Anschluss 

         powerCon blue 

 

 

 

Bei Portable Geräten mit Aufputzgehäuse sind der RJ45-Anschluss und die Stromversorgung seit-
lich ausgeführt. Zum Stromversorgung wird ein blauer powerCon eingesetzt.  

 

  



MasterPort 2 

18 

   

 

 

Spannungsversorgung  

Die Spannungsversorgung des MasterPort 2 kann wahlweise per Power-over-Ethernet (PoE) oder 
mit einem externen Netzteil (24V DC) erfolgen. Bei PoE erfolgt die Spannungsversorgung direkt 
über den Ethernet-Anschluss. Wird ein externes Netzteil eingesetzt, erfolgt die Spannungsversor-
gung der Steuereinheit über den oberen grünen Phoenix-Steckverbinder. 

 

Wird der MasterPort 2 sowohl über PoE als auch über ein externes Netzteil mit Spannung 
versorgt, hat die Versorgung über PoE Priorität! 

 

Ethernet 

Der MasterPort 2 ist mit einer RJ-45-Ethernet-Schnittstelle ausgerüstet, die eine IEEE-Belegung für 
100BaseTx und Power-over-Ethernet (PoE) gemäß Standard IEEE 802.3af unterstützt.  

 

Optionale rückseitige DMX-Anschlüsse 

Optional können die vorderen vier DMX-Anschlüsse auch rückseitig als 3pin-Steckanschlüsse aus-
geführt werden. Diese sekundären DMX-Anschlüsse sind zu den XLR-Anschlüssen parallel geschal-
tet und entsprechen in der Software-Konfiguration immer ihrem vorderseitigen Pendant.  

 

Diese DMX-Anschlüsse sind nicht elektrisch isoliert! 

 

Die Bestückung mit Anschlusspins ist eine Bestelloption und kann nicht nachträglich reali-
siert werden! 
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Konfiguration des MasterPort 2 
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Hinweise zur Bedienung des Menüs 

Aufbau und Auswahl 

Die Menüstruktur des MasterPort 2 ist hierarchisch angeordnet. Die erste Ebene ist der Grundzu-
stand, von dem der Zugriff auf das Hauptmenü erfolgt. Vom Hauptmenü sind die weiteren Unter-
menüs thematisch in Ebenen unterteilt.  

 

Menüauswahl 

Drehen am Encoder wählt die unterschiedlichen Menüpunkte und Schaltflächen durch ein wan-
derndes ►. Ein kurzes Drücken auf den Encoder öffnet diesen Menüpunkt oder bestätigt die EIn-
stellung. 

 

Ändern von Einstellungen 

Der ausgewählte Parameter wird mit einem  invers blinkenden  ersten Zeichen dargestellt und 
kann nun durch Drehen am Encoder verändert werden. Erneutes Drücken übernimmt die Einstel-
lung, die veränderten Parameter werden dann sofort wirksam. 

 

Das Bestätigen der Schaltfläche „◄“ führt die MasterPort 2-Steuereinheit in das übergeordnete 
Menü zurück. Bevor dieses Menü angezeigt wird, werden Sie gefragt, ob Sie die geänderten Para-
meter speichern möchten.  

 

Speichern von Parametern 

Möchten Sie eingestellte Parameter speichern, wählen und bestätigen Sie die Nachfrage mit „Yes“. 
Die geänderten Werte werden dauerhaft gespeichert. Mit „No“ kehren Sie in das vorhergehende 
Menü zurück, geänderte Werte werden nicht gespeichert, auch wenn sie bereits temporär einge-
stellt waren. 

 

Wird über einen einstellbaren Zeitraum der Encoder nicht betätig, wird der Grundzustand akti-
viert. Dabei wird das Gerät wieder gegen unbefugte Bedienung verriegelt und das eingegebene 
Passwort gelöscht. Nicht gespeicherte Änderungen im aktuell geöffneten Menü gehen verloren. 
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Legende zur Schematische Darstellung des Menüs 

Der Aufbau des Menüs und die Konfigurationsmöglichkeiten werden im Folgenden schematisch 
dargestellt. Die verwendeten Symbole haben folgende Bedeutung: 

 

Symbol Bedeutung 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Display-Anzeige 

 

 

 

 

Anzeigenname 

 

 

Anzeigen/Parameter zur Auswahl 

 

 

 

 Auswahl durch Drehen des Encoders 

 Bestätigen durch Drücken des Encoders 

 Stellt dar, zu welcher Display-Anzeige Auswahl führt 
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Grundzustand 

 

Im Grundzustand scrollt das Menü des MasterPort 2 durch verschiedene Diagnoseseiten. Diese 
Seiten geben einen schnellen Überblick über verschiedene Einstellungen und den Betriebszustand 
des Geräts.  

 

Es ist möglich, den automatischen Scroll durch Drehen des Encoders zu unterbrechen und durch 
weiteres Drehen manuell die Seiten aufzurufen. Der automatische Scroll wird mittels eines blin-
kenden -Symbols rechts oben angezeigt. Beim Wechsel zum manuellen Scroll ändert sich das 
Symbol in II. 
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Hauptmenü 

PIN-Abfrage 

Vom Hauptmenü aus werden alle anderen Menüs, wie Anzeige-, Konfigurations- und weitere Ein-
stellungsmenüs aufgerufen. Falls eine PIN vergeben wurde, wird diese vor dem Hauptmenü abge-
fragt: 

 

 
 

Die Eingabe der Pin erfolgt mit dem Encoder. Zur Sicherheit wird vor und nach dem Scrollen nur 
[*****] angezeigt. 

 

Aufbau Hauptmenü 

Vom Hauptmenü aus werden alle anderen Menüs aufgerufen. Um vom Grundzustand aus das 
Hauptmenü aufrufen zu können, muss die Taste „MENU“ gedrückt werden.  

Das Hauptmenü ist unterteilt in Monitoring-Menüs, Konfigurationsmenüs und weitere Einstellun-
gen. 

 

 
 

Auswahl Bedeutung 

View Auswahl der Netzwerk- und DMX-Monitore 

Config Auswahl des Menüs zur Einstellung des MasterPort 2 

Options Auswahl des Menüs zur Einstellung der Zusatzfunktionen 

◄ Zurück in Grundzustand. 
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View-Menü 

Mit den Monitoren im View-Menü erhalten Sie einen Überblick über die aktuellen Einstellungen 
des MasterPort 2. Aktuelle Ereignisse, Daten-In- und –Output werden ebenso dargestellt wie die 
Merge-Situation. Die Anzeigen im View-Menü verstehen sich als Monitore und sind in Echtzeit. 
Dadurch lassen sie sich problemlos als Überwachungs- und Diagnosetools einsetzen. 

 

Aufbau des View-Menüs 
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View→DMX 

Dieser Monitor gibt einen Überblick über die Aktivitäten an den DMX-Ports. Im Untermenü für alle 
Ports können die Signale für jedes Bit hexadezimal oder prozentual dargestellt werden.  

 

Anzeige Bedeutung 

DMX 1…4 DMX-Port 1…4 

IN Das Symbol ist nur bei DMX-In Ports vorhanden. 

voll: am DMX-Eingang wird ein korrektes DMX-Protokoll empfangen 

E: DMX-Protokoll an dem Eingang ist ungültig (Startcode oder Timing) 

leer: kein Signal am DMX-Eingang 

OUT Das Symbol ist nur bei DMX-Out Ports vorhanden. 

voll: am DMX-Ausgang wird DMX gesendet 

H: DMX-Ausgang ist auf HOLD und hält die letzten Daten 

Z: DMX-Ausgang ist auf HOLD und sendet Nullprotokolle 

leer: DMX-Ausgang ist abgeschaltet 

Cnt Anzeige der gesendeten Pakete pro Sekunde. 

F Anzeige der Framerate pro Sekunde 

► Untermenü aufrufen 

◄ Rückkehr ins übergeordnete Menü 

 

View→RDM 

In diesem Menü können Informationen über die RDM Aktivitäten im Netzwerk angezeigt werden.  

 

Anzeige Bedeutung 

Port ○: RDM ist an diesem Port aktiviert. Der Port kann ausgewählt werden 
 und zeigt dann Informationen zu RDM-Geräten im Universe. 

-: RDM ist an diesem Port deaktiviert 

Disc Ist RDM am jeweiligen Port deaktiviert, werden keine Symbole angezeigt. 

○: Discovery ist aktiviert, kein Polling 

●: Discovery ist aktiviert, Polling ist aktiv 

Dev Anzahl der im Universe gefundenen Geräte 

► Untermenü aufrufen 

◄ Rückkehr ins übergeordnete Menü 
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View→Network 

View→Network→Monitor 

 

In diesem Monitor werden die aktuellen Einstellungen an den DMX-Ports angezeigt.  

 

Anzeige Bedeutung 

1…4 DMX 1…4 

Act voll: auf dieser Subnet/Universe-Kombination wird Licht empfangen 

leer: auf dieser Subnet/Universe-Kombination wird kein Licht empfangen 

Sub logisches Subnet (lichtprotokollabhängig) 

Wenn der DMX-Port im Routing abgeschaltet ist oder das gewählte Licht-
protokoll keine Subnets kennt, wird „-“ angezeigt. 

Uni Universe (lichtprotokollabhängig) 

Wenn der DMX-Port im Routing abgeschaltet ist oder das gewählte Licht-
protokoll keine Universes kennt, wird „-“ angezeigt. 

► Untermenü aufrufen 

◄ Rückkehr ins übergeordnete Menü 

 

 

View→Network→Counter 

Dieses Auswahlmenü führt zu Monitoren, die einen Überblick über eingehende und ausgehende 
Daten und Datenpakete geben. Die Monitore geben ihre Informationen sehr umfangreich wieder, 
so dass man diese Informationen durchaus zur Netzwerkdiagnose nutzen kann. 

 

Anzeige Bedeutung 

In Aufruf Netzwerkzähleranzeigen für empfangene Daten 

Out Aufruf Netzwerkzähleranzeigen für gesendete Daten 

Data Aufruf Netzwerkzähler für Datenpakete 

► Menü aufrufen 

◄ Rückkehr ins übergeordnete Menü 
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View→Network→Counter→In/Out 

 

Anzeige Bedeutung 

kByte empfangene kByte 

Packets empfangene Pakete 

Errors Summe der Empfangsfehler 

Dropped Empfangsüberlauf durch zu viele Pakete 

Overrun (nur In) Empfangsüberlauf durch zu viele Pakete 

Aborted (nur Out) Abgebrochene Pakete 

Length (nur In) Pakete mit Längenfehler 

Carrier (nur Out) Ethernet-Carrier verloren 

CRC (nur In) CRC-Empfangsfehler 

Heartbt (nur Out) Ethernet Heartbeat verloren 

Frame Frame Fehler 

FIFO Überlauf Ethernet FIFO 

◄ Rückkehr ins übergeordnete Menü 

 
 

View→Network→Counter→Data 

 

Anzeige Bedeutung 

Rx Empfangene Datenmengen 

Tx Gesendete Datenmengen 

Pack./s Pakete pro Sekunde 

kByte Datenmenge in kByte 

◄ Rückkehr ins übergeordnete Menü 
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Config-Menü 

Möglichkeiten des Configuration-Menüs 

Im Config-Menü können Sie die vielfältigen Einstellungsmöglichkeiten des MasterPort 2 komforta-
bel ändern. Zu Ihrer eigenen Sicherheit müssen Sie vor jeder Änderung der Einstellungen diese 
Änderung auch bestätigen.  

 

Bitte beachten Sie, dass jede Änderung der Einstellungen weitreichende Folgen auf Ih-
re Lichtanlage haben kann. Die folgend beschriebenen Einstellungsmöglichkeiten set-
zen auch voraus, dass Sie Erfahrungen und Kenntnisse in der Konfiguration von DMX 
und von Ethernet-Lichtprotokollen besitzen.  

 

Aufbau des Config-Menüs 

 

 
 

Menü Einstellungsmöglichkeiten 

Routing Einstellung des Merge-Verhaltens 

DMX Einstellung des Verhaltens der DMX-Ausgänge bei Signalverlust 

Network Einstellung der Ethernet-basierenden Netzwerkprotokolle 

Ports Einstellung der Ports als IN oder OUTs 

► Menü aufrufen 

◄ Rückkehr ins übergeordnete Menü/Parameter speichern 
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Config→Routing 

Im Routing findet die Zuordnung der DMX-Ports zu den Ethernet Universes und Subnets statt. Au-
ßerdem wird hier festgelegt, was gemergt wird und ob der Port überhaupt aktiv ist. 

 

 

 
 

Anzeige Bedeutung 

Port 1 Einstellungen für Port 1 

Port 2 Einstellungen für Port 2 

Port 3 Einstellungen für Port 3 

Port 4 Einstellungen für Port 4 

► Menü aufrufen 

◄ Rückkehr ins übergeordnete Menü 
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Config→Routing→Port ist IN 

Unabhängig von seiner Bauform (male oder female) können die DMX-Ports per Software als IN 
oder OUT definiert werden. Die Definition erfolgt unter Config→Ports. 

 

Auswahl Bedeutung 

Mode Off: Daten werden empfangen, aber nicht verarbeitet oder gesendet 
 (Prinzip Sackgasse). 

On: Daten werden empfangen, verarbeitet und gesendet. 

Universe Einstellung des DMX-Universe in das gesendet werden soll 

Extra Universes Einstellung von bis zu 16 Univeres 

Subnet Einstellung des Ethernet-Subnets in das gesendet werden soll. 

► Parameter einstellen 

◄ Rückkehr ins übergeordnete Menü/Parameter speichern 

 

Bei der Einstellung des Extra Universes muss die unterschiedliche Zählweise der Protokolle beach-
tet werden. Im ArtNet trägt das erste Universe die Ziffer 0, in allen anderen 1. Bei der Einstellung 
des Extra Universe unter ArtNet gilt folgende Routine: 

 

Gewünschtes Universe + 1 = einzustellendes Universe 

 

Der MasterPort 2 zeigt nach Bestätigung der Eingabe das gewünschte Universe an. 
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Config→Routing→Port ist OUT 

 

Auswahl Bedeutung 

Failmode Off: bei Empfangsausfall wird der DMX-Out abgeschaltet 

Hold: letzter empfangener Wert wird unverändert weitergesendet 

Zero: bei Empfangsausfall werden Datenpakete mit dem Wert „0“ ge-
 sendet 

Mode Einstellung der Merge-Quellen und der Merge-Art. 

 

Off: Ethernet wird nicht empfangen, DMX-Out abgeschaltet 

 

Single:  

Es werden nur die vom ersten Sender empfangenen Lichtdaten verwen-
det. Sollten gleichzeitig von mehreren Sendern Telegramme mit dem ein-
gestellten Subnetz und Universe anliegen, wird nur der als erstes er kann-
te Sender berücksichtigt. Die Sender-Erkennung erfolgt bei AVAB/IPX di-
rekt durch Auswertung der MAC-Adresse (Ethernetadresse), bei sACN 
nach der Geräte-ID und bei allen anderen Protokollen durch die IP-
Adresse des Senders, die für jeden Sender individuell sein muss. Bei Aus-
bleiben des Sendersignals wird nach der Timeout-Zeit (Pufferzeit) ggf. ein 
anderer Sender ermittelt (Prinzip: „Der erste darf“). 

 

Merge4: 

Es werden die Daten von bis zu 4 Ethernet-Sendern nach dem HTP-Prinzip 
zusammengefasst. Sollten gleichzeitig von mehr als 4 Sendern Telegram-
me mit dem Subnetz und Universe dieses Ausgangs anliegen, werden nur 
die ersten 4 erkannten Sender berücksichtigt. Bei Ausbleiben eines Sen-
dersignale wird nach der Timeout-Zeit ggf. ein anderer Sender ermittelt 
(Prinzip: „wer zuerst kommt“). 

Universe Einstellung des Sende-Universes 

Subnet Einstellung des Empfangs-Subnets (lichtprotokollabhängig) 

► Parameter einstellen 

◄ Rückkehr ins übergeordnete Menü/Parameter speichern 

 

  



MasterPort 2 

32 

   

 

 

Bei Protokollen mit Prioritäten gibt es folgende Besonderheiten: 

Protokoll Prioritätsbehandlung 

AVAB/UDP Bei Priorität  1…200 gewinnt die Anlage mit dem höchsten Prioritätswert. 

Mehrere gleiche der höchsten Priorität werden HTP- gemergt. 

Anlagen, die 0 senden (alte transtechnik-Versionen, DigiPlus usw.) wer-
den immer mit der höchsten Priorität zusammen HTP-gemergt. 

sACN Bei Priorität  1…200 gewinnt die Anlage mit dem höchsten Prioritätswert. 

Mehrere gleiche der höchsten Priorität werden HTP- gemergt. 

Anlagen, die 0 senden, werden wie Priorität 100 behandelt. 

 

Config→DMX 

In diesem Menü werden das Verhalten der DMX-Out bei Empfangsausfall sowie das Timing des ge-
sendeten DMX-Protokolls festgelegt. 
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Anzeige Bedeutung 

Def Lädt die Default-Werte aller Einstellungen, die in diesem Menü und 
den Untermenüs möglich sind. 

RDM 

RDM ●: Schaltet das RDM für das gewählte Universe ein. 

○: Schaltet das RDM für das gewählte Universe aus. 

Discovery ●: Aktiviert die RDM-Discovery Funktion für das  

 ausgewählte Universe. 

○: Deaktiviert die RDM-Discovery Funktion für das  

 ausgewählte Universe. 

 

 Eine neu angestoßene volle RDM-Discovery verursacht 
 kurzzeitig hohen Datentraffic im Universe und kann die 
 DMX-Steuerung beeinträchtigen! 

Intervall Stellt die Intervallzeiten der inkrementellen Discovery in Sekunden 
ein. 

Incremental Mit dieser Funktion ist RDM-Discovery immer aktiv! Es werden im-
mer Daten gesammelt und Identifizierungsanfragen für neue Geräte 
in die Universen gesendet.  

On: Incremental discovery ist immer aktiv. 

Off: Incremental discovery ist nicht aktiv. 

Background Mit dieser Funktion arbeitet die inkrementelle Discovery im Hinter-
grund. Dadurch wird das DMX-Signal weniger gestört. Allerdings kann 
es sein, dass sich die Intervallzeit weit über oben eingestellte hinaus 
verlängert! 

On: Background discovery ist aktiv. 

Off: Background discovery ist nicht aktiv. 

Break Einstellung der Breaklänge von 90…999 µs 

MAB Einstellung der Mark-after-Break-Länge von 20…999 µs 

MBF Anzahl der pro Sekunde gesendeten DMX-Protokolle. Beim Wert = 44 
wird das DMX-Signal mit maximaler Geschwindigkeit gesendet. Mit 
Werten < 44 wird durch Dehnung der Zeit zwischen den Bytes die 
Protokollrate auf den angezeigten Wert verringert. 

Channels Einstellung der Länge des DMX-Protokolls 

► Parameter einstellen 

◄ Rückkehr ins übergeordnete Menü/Parameter speichern 
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Config→Network 

Im Network-Menü werden die auf dem Ethernet basierenden Netzwerkprotokolle eingestellt. 
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Anzeige Bedeutung 

Rx Prot Einstellung des Lichtprotokolls beim Datenempfang: 

 Art-Net  ShowNet 

 AVAB/IPX  sACN 

 AVAB/UDP  
 

Rx Tmo Einstellung des Timeouts beim Datenempfang 1…999 s   

Tx Prot Einstellung des Sendenetzwerkprotokolls: 

 Art-Net  ShowNet 

 AVAB/IPX  sACN 

 AVAB/UDP  
 

Tx Rate Einstellung der Mindest-Senderate für Lichtprotokolle, wenn sich keine Werte än-
dern:  20ms, 40ms, 80ms, 100ms, 200ms, 500ms, 1s, 2s, 3s, 4s 

IP Mode Bezug der IP-Adresse: 

Manual:  freie Einstellmöglichkeit 

Art-Net 2:  Art-Net-Adresse im 2er Netz 

Art-Net 10:  Art-Net-Adresse im 10er Netz 

DHCP:   wenn DHCP-Server im Netzwerk vorhanden 

IP IP-Adresse   die manuelle Eingabe ist nur bei „IP Mode = Manual“ möglich 

SN Netzwerkmaske die manuelle Eingabe ist nur bei „IP Mode = Manual“ möglich 

GW Gateway  eine Änderung einer voreingestellten Adresse ist nur in  
   Ausnahmefällen notwendig 

Name Einstellung des Art-Net ShortName zur Benennung des MasterPort 2 ; z.B. Standort 
„Hinterbühne“ 

SLPv2 Einstellung des Service Location Protocol 

On:   Aktiviert das SLP Netzwerkprotokoll 

Off:   Deaktiviert das SLP Netzwerkprotokoll 

RDM Einstellung wie RDM über Ethernet an Auswertungsgeräte gesandt wird. 

Off:   Der MasterPort 2 sendet kein RDM über Ethernet 

ArtNet:  RDM-daten werden über ArtNet gesendet. 

RDMNet:  nicht zertifiziertes Protokoll 

Telnet Schaltet das Telnet-Protokoll für Logmeldungen 

On:   Aktiviert Telnet 

Off:   Deaktiviert Telnet 
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Anzeige Bedeutung 

sACN 
Draft 

Auswahl des unterstützen sACN-Protokolls 

Off   MasterPort 2 sendet sACN nach Standard E1.31 2009 

On   MasterPort 2 sendet sACN nach Standard E1.31 R0 Draft 

Art-Net 
BC 

Art-Net wird als Broadcast gesendet. Dies ist bei der Ansteuerung von ADB-Anlagen 
notwendig. 

Art-
Net3Nw 

Einstellung der Art-Net3 IP-Adresse.  

0:   Art-Net3 ist deaktiviert 

1  127:   Art-Net3 ist aktiv und Ziffer gibt die IP-Adresse an. 

UDPCh-
ksm 

Einstellung zur Berechnung der Prüfsummen von UDP-Datenpaketen 

Rx & Tx  Prüfsummen für empfangene und gesendete Pakete 

Rx only   Prüfsummen nur für empfangene Pakete 

Tx only   Prüfsummen nur für gesendete Pakete 

Off   Prüfsummenberechnung aus 

EthMedia Einstellung der Übertragungsgeschwindigkeit 

Autoneg.  Automatische Ermittlung der Übertragungsgeschwindigkeit 

10 Half   10MBit/s Half Duplex 

10 Full   10MBit/s Full Duplex 

100 Half  100MBit/s Half Duplex 

100 Full  100MBit/s Full Duplex 

► Parameter einstellen 

◄ Rückkehr ins übergeordnete Menü/Parameter speichern 
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Config→Ports 

Die DMX-Ports des LSS MasterPort 2 können unabhängig ihrer physikalischen Bauform, also ob sie 
als Male oder Female ausgeführt sind, per Menüeinstellung definiert werden. Wie die Ports aktu-
elle definiert sind, wird im Grundzustand auf Seite 6 angezeigt. 

 

 

 
 

Anzeige Bedeutung 

Port 1 Aufruf der Einstellungen für PSU-Port 1 

Port 2 Aufruf der Einstellungen für PSU-Port 2 

Port 3 Aufruf der Einstellungen für PSU-Port 3 

Port 4 Aufruf der Einstellungen für PSU-Port 4 

► Menü aufrufen 

◄ Rückkehr ins übergeordnete Menü 
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Config→Ports→Port x 

 

Auswahl Bedeutung 

Enable On: Der DMX-Port ist manuell eingeschaltet. 

Off: Der DMX-Port ist manuell ausgeschaltet. 

In ●: Der DMX-Port ist als IN definiert. 

○: Der DMX-Port ist nicht als IN definiert. 

Out ●: Der DMX-Port ist als OUT definiert. 

○: Der DMX-Port ist nicht als OUT definiert. 

► Parameter einstellen 

◄ Rückkehr ins übergeordnete Menü/Parameter speichern 

 
Die Definition der DMX-Ports ist von aussen nur durch die Anzeigen im Display ersichtlich. Vor An-
schluss eines Kabels sollte die Definition geprüft werden. 
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Options 

Im Menü Options werden die Zusatzeinstellungen des MasterPort 2 festgelegt. 

 

Aufbau des Menüs Options 

 

 
 

Menü Einstellungsmöglichkeiten 

Display Einstellung des Displays 

Security Einstellung der Sicherheitseinrichtung 

Default Laden von Default-Werten 

Reset Reset der Steuer-CPU 

► Menü aufrufen/Funktion ausführen 

◄ Rückkehr ins übergeordnete Menü 
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Options→Display 

Hier werden die Einstellungen für das Display festgelegt. 
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Auswahl Bedeutung 

Contrast Einstellung des Kontrasts des Displays 

MenuTimeout Timeout für Verlassen des Menüs bei Nichteingabe und Rückkehr zum Grund-
zustand 

(OFF, 15s, 30s, 1m, 3m, 5m, 10m, 15m, 20m, 30m, 45m, 1h, 2h, 3h, 4h, 6h, 8h, 
12h, 24h) 

ScreenSaver Timeout für Backlight-Abschaltung des Displays. Die Abschaltung des Back-
lights erhöht die Lebensdauer des Displays erheblich.  

Eingaben am Encoder, per Remote-Steuerung oder Events beenden den Zu-
stand. 

(OFF, 15s, 30s, 1m, 3m, 5m, 10m, 15m, 20m, 30m, 45m, 1h, 2h, 3h, 4h, 6h, 8h, 
12h, 24h) 

Front LEDs Off:   Alle Statusmeldungen der Betriebs-LEDs sind deaktiviert. Es 
  werden keine Meldungen angezeigt. 

On:  Alle Statusmeldungen der Betriebs-LEDs sind aktiviert.  

  Änderung der Einstellung ist erst mit Hardware-Revision 14 
  möglich. Bei den vorhergehenden haben Einstellungen keine 
  Auswirkungen auf die LEDs. 

Events On:  Statusänderungen an DMX-In/Out oder Ethernet schalten 
  Bildschirmschoner aus und zeigen die jeweilige Statusseite  

Off:  Statusänderungen wirken sich nicht auf Bildschirmschoner 
  aus 

Default Definierung einer dem Grundzustand übergeordneten Anzeige 

Scroll:  Grundzustand scrollt normal  

UserTxt: Anzeige eines selbstformulierten Textes. Bei Aktivierung wird 
  unterhalb der Zeile eine weitere Eingabemaske zur Texteingabe 
  angezeigt. 

FixScoll: Eine bestimmte Diagnoseseite aus dem “First Level” wird  
  dauerhaft angezeigt. Wenn aktiviert, wird unterhalb der Zeile 
  eine Auswahl der Seiten eingeblendet. 

  1: Serial – Zeigt Geräte- und Softwaredetails an 

  2:  Counters – Zeigt Zähler und Messdaten an 

  3: NW-Info – Zeigt Etherneteinstellungen an 

  4: In – Überblick über empfangene Ethernetdaten 

  5: Out – Überblick über gesendete DMX-Daten 

  6: PSU-State – Zeigt Ausgangsspannung und -strom an 

► Parameter einstellen 

◄ Rückkehr ins übergeordnete Menü/Parameter speichern 
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Aufbau der anderen Untermenüs 

 

 
 

Options→Security 

In diesem Menü werden die Sicherheitseinstellungen festgelegt. 

Auswahl Bedeutung 

Pin Hauptmenü-Pin 

0…30000s (0 = aus) 

Remote On: MasterPort 2 ist per ArtNet programmierbar 

Off: MasterPort 2 ist nicht per ArtNet programmierbar 

► Parameter einstellen 

◄ Rückkehr ins übergeordnete Menü/Parameter speichern 

 

Obwohl das System eine Auswahl aus 30.000 möglichen Pins bietet, kann eine abso-
lute Sicherheit nicht gewährleistet werden! Treffen Sie geeignete Maßnahmen vor 
Ort, um einen nicht autorisierten Zugriff zu verhindern! 
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Options→Factory Defaults  

Hier werden alle Einstellungen der Steuereinheit des MasterPort 2 auf die Werkseinstellungen zu-
rückgesetzt.  Um einen Datenverlust vorzubeugen, ist eine doppelte Bestätigung zum Laden der 
Default-Werte notwendig.  

 

Parameter Bedeutung 

No Abbruch des Rücksetzens 

Yes Rücksetzen der Einstellungen auf Werkseinstellungen gemäß letztes Firmware-
Update 

► Ausführen 

◄ Rückkehr ins übergeordnete Menü 

 

 

Options→Reset 

Mit der Anwahl dieses Menüpunktes wird ein CPU-Reset ausgelöst. Nach dem Reset werden die 
gespeicherten Parameter geladen.  

Beim Ändern folgender Einstellungen führt der MasterPort 2 nachfolgend automatisch einen Reset 
aus: 

 Lichtempfangsprotokoll  Lichtsendeprotokoll 

 IP-Mode  IP-Adresse 

 Netzwerkmaske  Gateway 

 Defaultwerte laden  

 

Options→Debug 

In diesem Menü können Meldungen der Platinen angezeigt werden. Die angezeigten Werte sind 
nur für den Service relevant. 
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Service 
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Werkseinstellungen 

Die Werkseinstellungen des MasterPort 2 sind: 

 Netzwerkprotokoll:   Art-Net (Empfang und Senden) 

 IP-Mode:   Art-Net 2er Netz 

 IP Adresse:    gemäß Art-Net Standard (2.x.y.z) 

 Netzwerk-Maske:  255.0.0.0 

 Gateway:   192.168.172.254 

 Mindest-Senderate:  1/s 

 Empfangstimeout:   8 s 

 Routing DMX-Ports 1…4: Subnet 0, Universe 0…3 

 Routing DMX-In:  Ethernet-Senden ON, Priorität 0 

 Routing DMX-Out:  Ethernet-Empfang:  MERGE4 

 DMX-Out Verhalten:  OFF  (Abschalten bei Empfangsausfall) 

 DMX-Out Timing:  Break:  200 µ 

MAB:  20 µ 

 Art-Net ShortName:   LSS MasterPort 2 

 Art-Net LongName:   MasterPort 2  (c)2012 LSS GmbH      Version x.xx 

 Bildschirmschoner:  15 min, aus bei Statusänderungen 

 Pinabfrage:   aus 

 Art-Net Fernsteuerung: ein 
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Kontaktaufnahme 

Falls Probleme beim Betrieb des LSS MasterPort 2 auftreten, sollten die Beschreibungen und Hin-
weise in diesem Handbuch zur Fehleranalyse und Fehlerbehebung weiterhelfen. Sollte dies nicht 
der Fall und es werden weiterführende Hilfestellungen benötigt, wenden Sie sich an den LSS Ser-
vice. 

 

Bei der Kontaktaufnahme sollten folgende Informationen vorliegen: 

 

- Ort der Gesamtanlage und Position des MasterPort 2 

 

- Ausführliche Fehlerbeschreibung 

 

- Ausführliche Beschreibung der bisher erfolgten Fehlersuche 
 

- Beschreibung zusammenhängender System- oder Geräteprobleme 

 

 

Kontaktadresse: 

LSS GmbH 

Licht-, Steuer- und Schaltanlagenbau GmbH 

Am Eichenberg 1 

D-04600 Altenburg 

Tel.: +49 3447 83550 

Fax: +49 3447 861779 

mail@lss-lighting.de 

 

  



MasterPort 2 

 

LSS 
47 

 

 

 

Anhänge  
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Technische Daten 

Bauart: Panel-Einbaugerät 
 

Gerät Abmessung Gewicht 

Einbaugerät für Gehäuse 130 x 68 x 155mm Ca. 0,7kg 

Einbaugerät für LSS Dimmerkanäle 130 x 68 x 150mm Ca. 0,7 kg 

Einbaugerät für Aufputzgehäuse 200 x 76 x 155mm Ca. 3,0kg 

Portable mit Schutzbügel 215 x 213 x 175mm Ca. 4,5kg 

 
EMV-Standards: EN 55022, class B, FCC part 15, level B 
RoHS: konform 
Lieferumfang: Fertiggerät 
 
CPU-Typ: Infineon XE167 
Taktfrequenz: 80 MHz 
Kühlung: lüfterlos, passiv 
Stromversorgung: 24V DC oder PoE nach IEEE 802.3af 
Leistungsaufnahme: 
Konfiguration: Menüsystem mit Display und Encoder 
 

Stromversorgung PSU:   24V DC  

Betriebstemperatur: 0° - 40°C 
Leistungsaufnahme: 7- 14W 
 
 

Netzwerk 

DMX 

Allgemein 

DMX-Protokoll: DMX-512  
Standards: USITT 1990, DIN 56930-2, ANSI E1.11 
Baudrate: 250 kbps 
DMX: Frontseite:  4x 5pin XLR female 
   einzeln potentialgetrennt mittels  
   Optokoppler  
   (ISOLATED nach ANSI E1.11 A1) 
 Rückseite: 4x 4pin XLR Sockel male 
   Ohne Potentialtrennung!  
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Empfang 

Startcode: =0    Lichtprotokoll (in Display ●) 

 <>0  kein Lichtprotokoll, RDM (in Display  E) 
minimale Protokollänge: nur Startcode 
maximale Protokollänge: Startcode + 512 Werte 
 (Werte über 512 gehen verloren) 

minimale Durchlaufverzögerung: 44 s 
maximale Durchlaufverzögerung: 22,5 ms 
Empfangstimeout: 2 s 
max. Abstand zwischen 2 Protokollen: 2 s 

Minimale erkannte Breaklänge: 48 s 
Maximal zulässige Breaklänge: 1,95 s 
 

Senden 

Startcode: 0 
Protokollänge: Startcode + 512 Werte 
Minimale Protokollzeit: 22,4 ms 
Gesendete Protokolle / s: 44 
Breaklänge: 90…999 µs (einstellbar) 
Mark After Break: 20…999 µs (einstellbar) 
Pause nach Startcode: 25 µs 
 
 

Ethernet 

Allgemeines 

Schnittstelle:  RJ-45, IEEE-Belegung für 100BaseTx und Power-over-
Ethernet nach IEEE 802.3af 

Geschwindigkeit: 10 MBit/s, 100MBit/s; Autonegotiation 
Duplex-Mode: halb, voll; Autonegotiation 
 Auto-MDI/MDIX 
Anzeige: Link-LED, Data-LED, Geschwindigkeit und Duplex-Mode 

werden im Display angezeigt 
Lichtprotokolle: Art-Net (ArtisticLicence) 
 AVAB-IPX (AVAB, transtechnik, LDDE,…) 

 AVAB/UDP (transtechnik) 
 ShowNet (Strand Lighting) 

 sACN (ANSI E1.31) 
weitere Netzwerkprotokolle: ARP, IP, IPX, UDP, IGMPv2 
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Empfang 

Maximale Paketrate: >1000/s (bei 1 Lichtframe/Paket) 

Minimale Durchlaufverzögerung: 4 s 
Maximale Durchlaufverzögerung: 22,7 ms 
Max. Abstand zwischen 2 Protokollen: 1...999 s  (Halten per DMX-Out einstellbar) 
 
 

Senden 

Senderate bei Wertänderung: maximal aller 20 ms 
Senderate ohne Wertänderung: 20 ms … 4 s  (einstellbar) 
 

Anschlussbelegung 

DMX Ports 

DMX Frontseite 

Belegung nach DMX512-Standard 

 

Pin Belegung 

1 DMX_Ground 

2 Data - 

3 Data + 

4 Spare 

5 Spare  

 

PE kann über die Schirmung geführt werden 

 

DMX Rückseite 

 

Pin Belegung 

1 DMX_Ground 

2 Data - 

3 Data + 

 
  



MasterPort 2 

 

LSS 
51 

 

 

 

Ethernet 

Der Ethernet-Anschluss unterstützt Power-over-Ethernet nach IEEE 802.3af 

 

Pin Belegung 

1 Rx + 

2 Rx - 

3 Tx + 

4 V + 

5 V + 

6 Tx - 

7 V - 

8 V - 

S Kabelschirm 

 
 

Bestellnummer 

5063:       4x DMX-OUT 


